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Introduction 

Data security nowadays is the burning issue not only for companies and government agencies, but rank and file people 

as well. Our personality is now fully embedded in computer technology. It is computer you apply to when at work, it is 

also computer you use at home for entertainment or as a reservoir for containing some valuable data such as personal 

correspondence, banking account information, credit card numbers, financial records, whatever… It is obvious that this 

kind of data should in no way be available to others. That is why, when disposing of a storage device (a hard disk or a 

flash memory drive), the crucial thing is to make sure it does not contain any information, because simple deletion, or 

even reformatting do not guarantee data security at all. To do that, you need a specially designed tool. 

Paragon Disk Wiper™ 12 Professional is a fast, convenient and reliable solution providing irreversible destruction of data 

on separate partitions or entire hard disks (IDE, SCSI, SATA, USB, etc.) as well as any type of flash memory devices. 

In this manual you will find the answers to many of the technical questions, which might arise while using the program. 

 

 

Our company is constantly releasing new versions and updates to its software, that's why 

images shown in this manual may be different from what you see on your screen. 

 

What’s New in Disk Wiper 12 

 Support of Windows 8. 

 Support of GPT/uEFI configurations to successfully clone, migrate, or restore a 64-bit Windows configured to 

the uEFI-based boot mode; to fix uEFI related boot problems. 

 WinPE traceroute/ping utility to get detailed information on particular routes and measure transit delays of 

packets across an Internet Protocol (IP) network. 

 Support of the restart-free installation. 

Product Components 

In order to cope with different tasks, the product contains several components: 

 Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you 

may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and 

cloning, etc. 

 Linux/DOS based environment is a multi-platform bootable media that enables to run utilities under Linux or 

PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both platforms 

have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB devices. It 

enables to burn CD/DVD discs. However there can be some difficulties with detecting new hardware. DOS in its 

turn has no problems of that kind but is limited in features. The Linux/DOS environment requires no installation 

and can be of great help when the system fails to boot. Besides it offers a Windows XP like environment. 

 WinPE based environment. Especially for keen followers of Windows, our product offers the option to prepare 

a WinPE based bootable media. Unlike the Linux/DOS environment it can boast an excellent hardware support 

and the same interface as the Windows version can. However its system requirements are much tougher. 
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Features Overview 

This chapter dwells upon key benefits and technical highlights of the product. 

Features  

Let us list some of the features: 

User Friendly Fault Minimizing Interface 

 Graphical representation of the data to gain a better understanding. 

 A handy Launcher to easily find and run the required tasks. 

 Comprehensive wizards to simplify even the most complex operations. 

 A context sensitive hint system for all functions of the program.  

 Previewing the resulting layout of hard disks before actually executing operations (so-called virtual 

operations). 

Partition/Hard Disk Management Facilities 

 Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the 

standard Windows disk tools, the program supports all popular file systems. 

 Mount a partition (assign a drive letter) of any file system type to make it available for your operating system. 

Wipe Facilities 

 Data wiping to successfully destroy all on-disk information including the standard bootstrap code and other 

system service structures. 

 Free space clearing to destroy any remnants of deleted files/directories left on disk without affecting the used 

data. 

Automatization Facilities 

 Task scheduling to automate routine operations. It can be particularly effective when you have to repeat a 

sequence of actions on a regular basis. 

 

 
Scheduling is only available for the Windows installation of the program. 

 

 Scripting to make the program create a script of any set of operations you need. Besides support of all 

operations available in the interactive mode, the unattended mode provides some additional features, such as 

conditional execution, subroutines, repeatable iterations, disk/partition properties analysis, errors 

management, etc. 

Auxiliary Facilities 

 File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD 

as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to 

replace corrupted data from a previously created image in case of an operating system failure. 

 Wiping Media Builder to create a bootable media on a CD, DVD disc, or flash memory, which can later be used 

to boot and irreversibly destroy the on-disk data. Moreover, with its help you can save data from partitions of 
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your hard disk directly to compact discs or burn ISO-images. The utility supports various formats of laser discs: 

CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning. 

 Network Configuration Wizard to establish a network connection on a wiping media. 

 Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or 

a boot virus activity. 

 

 
Boot Corrector is only available for the bootable environment. 

 

Supported Data Erasure Algorithms 

 US DoD 5220.22-M 

 US Navy standards NAVSO P-5239-26 

 British HMG Infosec Standard No.5 

 German VSItR Standard 

 Australian ASCI 33 

 Russian GOST R 50739-95 

 Peter Gutmann's algorithm 

 Bruce Schneier's algorithm 

 Paragon's algorithm 

 Custom algorithm 
 

 
To know more on the subject, please consult the Data Security Standards section. 

 

Supported Technologies 

Along with using innovative technologies from outside, Paragon has developed a number of its own original 

technologies that make its products unique and attractive for customers: 

 Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify 

and copy files and folders, etc. 

 Paragon BTE™ technology to set tasks for execution during the system restart, thus saving from the need to use 

a bootable media when modifying system partitions. 

 Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility 

without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale 

businesses when dealing with many physical hard disks involving complex setup. 

 GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift 

restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux. 

Supported File Systems 

 Full read/write access to FAT16/FAT32 partitions. 

 Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also 

supported. 
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 Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions. 

 Limited read/write access to Apple HFS+ partitions. 

 

 

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at 

the moment. The company is about to implement it in the nearest future. 

 

Supported Media 

 Support of both MBR and GPT hard disks (2.2TB+ disks included) 

 IDE, SCSI and SATA hard disks 

 SSD (Solid State Drive) 

 AFD (Advanced Format Drive) 

 Non-512B sector size drives 

 CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs 

 FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks 

 PC card storage devices (MBR and GPT flash memory, etc.) 

Getting Started 

In this chapter you will find all the information necessary to get the product ready to use. 

System Requirements 

For the Windows installation package 

 Operating systems: 

- Windows XP (32 and 64 bit) 

- Windows Vista (32 and 64 bit) 

- Windows 7 (32 and 64 bit) 

- Windows 8 (32 and 64 bit) 

 Internet Explorer 5.0 or higher  

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

 128 MB of RAM (256+ recommended) 

 Hard disk drive with 250 MB of available space  

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 
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During the installation additional free space (up to 1GB) will be required. 

 

For the Linux bootable environment 

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed 

 256 MB of RAM  

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

For the WinPE bootable environment 

 Intel Pentium III CPU or its equivalent, with  1000 MHz processor clock speed  

 At least 512 MB of RAM 

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

Additional requirements 

 Network card to send/retrieve data to/from a network computer 

 Recordable CD/DVD drive to burn data to compact discs 

 External USB hard drive to store data. 

Installation 

To install Paragon Disk Wiper 12, please do the following: 

1. Run Setup Application. Click on the *.MSI file. This application will guide you through the process of the 

program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user 

interface and set of installation steps. 

 

 

In case there is some previous version of the program installed on the computer, the 

program will offer the user to uninstall it first. 

 

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to 

continue. 

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the 

agreement and then select the appropriate option to accept. If you do not agree with any conditions stated 

there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also 

be printed out. 

4. Provide Registration Information. On the Registration page you are to provide your product key and serial 

number. 
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5. Provide Customer Information. On the Customer Information page you are to provide the standard 

information, i.e. a user name and an organization. Besides you need to decide whether to make the program 

available for all users of this computer (if several) or only for the current one. 

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will 

be installed. By default, the installation folder will be created as: 

C:\Program Files\Paragon\Paragon Disk Wiper 12. To select another folder, click the Change… button. 

After you have selected the required folder, click the Next button to continue. 

 

 

Do not install the program on network drives. Do not use Terminal Server sessions to install 

and run the program. In both cases, the program functionality will be limited. 

 

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or 

the Back button to return to any of the previous pages and modify the installation settings. 

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to 

abort the setup. 

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to 

complete the wizard. 

 

First Start 

To start Paragon Disk Wiper 12 under Windows, please click the Windows Start button and then select Programs > 

Paragon Disk Wiper™ 12 > Paragon Disk Wiper™. 

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization 

and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular 

basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page. 
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To know more on how to handle the product’s interface and accomplish typical operations, 

please consult the Windows Components chapter. 

 

Building wiping media 

Wiping Media Builder can help you accomplish the following operations: 

 Prepare the Linux/DOS environment (included in the installation package) on external media (CD, DVD, or flash 

memory) to boot and run utilities under Linux or PTS DOS (strongly recommended); 

 Prepare a custom Linux/DOS environment by adding any data you like to the standard image; 

 Prepare a bootable environment from any ISO image; 

 Create from the master CD the Linux/DOS environment on a CD/DVD disc, or flash memory. 

Below you can find how to build our Linux/DOS based recovery environment on a thumb drive: 

1. Plug in a thumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted. 

2. In the Main Menu: select Tools > Wiping Media Builder… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. On the Wizard's Welcome page, click the Next button. 

4. Select the Flash Memory option. 
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5. Select the Typical option. 

 

 

 

Please use Boot Media Builder to prepare the WinPE environment, which you can get here: 

www.paragon-software.com/my-account/. 

 

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if 

several). 

 

7. You will have to confirm the operation. 

 

Booting from the Linux/DOS wiping media 

The Linux/DOS environment can be used to boot your computer into Linux or PTS DOS to get access to your hard disk 

for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-standard 

situations such as interfering hardware settings or serious problems on the hardware level. In this case, only basic files 

and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded. 

Startup 

To start working with the Linux/DOS environment, please take the following steps: 

1. Start up the computer from our Linux/DOS wiping media. 

 

https://www.paragon-software.com/my-account/login.htm
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Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a 

thumb drive. 

To automatically boot from the wiping media please make sure the on-board BIOS is set up 

to boot from CD/USB first. 

 

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

 

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right 

choice. 

4. Consult the help system by pressing ALT+F1 to know more on the subject. 

Boot menu 

The Boot menu contains the following commands: 

 

 Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended); 

 Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it 

fails to work properly; 

 Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be 

included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu; 

 Floppy Disk. Reboot the computer from a system floppy disk; 

 Hard Disk 0. Boot from the primary hard disk; 

 Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating 

system. 

To move within the menu, please use the arrow keys of the computer keyboard. 

 

 

While working with the environment you might experience some inconvenience caused by 

possible video artifacts. It is just a result of changing video modes and in no way will affect 

the program functionality. If this is the case, please wait a bit and everything will be OK. 
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Normal Mode 

When the Normal mode is selected, the Linux launch menu appears: 

 

 Wipe Wizard (enables to destroy all on-disk information or only remnants of deleted files/directories); 

 File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to 

CD/DVD); 

 Boot Corrector (helps to correct the Windows System Registry without Windows being loaded); 

 Log Saver (helps to collect and send the necessary log files to the Technical Support); 

 Command Line (allows experienced users to execute any operation); 

 Reboot the computer; 

 Power off the computer. 

To move within the menu, please use the arrow keys of the computer keyboard. 

Safe Mode 

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the 

Normal mode except for the Network Configurator and Log Saver commands. Besides due to certain limitations of the 

PTS DOS environment, there is no possibility to burn CD/DVD discs. 

Low Graphics Safe Mode 

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks 

similar to the Safe mode but graphically simpler. 
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Booting from the WinPE wiping media 

The WinPE environment can be a real alternative to the Linux/DOS environment. Providing nearly the same level of 

functionality it offers an excellent hardware support and the same interface as the Windows version does. 

Startup 

To start working with the WinPE environment, please take the following steps: 

1. Start up the computer from our WinPE wiping media. 

 

 

Please use Boot Media Builder to prepare the WinPE environment, which you can get here: 

www.paragon-software.com/my-account/. 

To automatically boot from the wiping media please make sure the on-board BIOS is set up 

to boot from CD/USB first. 

 

2. Once it has been loaded, you will see the Universal Application Launcher. In general it enables to run 

components of the product, load drivers for undefined hardware or establish a network connection. 

https://www.paragon-software.com/my-account/login.htm
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3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right 

choice. 

4. Consult the help system by pressing ALT+F1 to know more on the subject. 

 

 

Our WinPE based environment offers excellent hardware support. However in case it 

doesn’t have a driver for your disk controller, your hard disks will be unavailable. Please 

consult the Adding specific drivers scenario to know how to tackle this issue. 

 

Basic Concepts  

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general 

notion of the operation performance and makes it easier for the user to operate the program. 

Data Sanitization 

Data security is a two-sided problem. It is to be made clear, that providing confidentiality implies not only information to 

be stored properly, but also be destroyed according to certain rules. The first step to protecting yourself is to know 

exactly which security precautions work and which do not. 

Many people believe the misconception that repartitioning a disk will result in complete destruction of its contents. 

Actually that is not quite so. Repartitioning the drive only alters references to partitions in the Partition Table, leaving all 

file data intact. In fact, there are a number of programs available to successfully recover previously deleted partitions. 

Formatting a drive also does not guarantee data destruction. Formatting procedure implies modification of the Master 

File Table (MFT) that keeps track of where file contents are stored on the disk and verification of each sector for 

consistency. Even a low-level format does not actually erase the file contents for good, since they can still be 
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resurrected from their deleted state with minimal effort by using the popular today Magnetic Force Microscopy 

technology. 

The only way to make sure that all the data has been erased from a hard drive is to overwrite all on-disk sectors with 

random patterns of ones and zeros. Although this sounds complex, there is an easy way to do this. 

The process of deliberately, irreversibly removing or destroying the data stored on a memory device (magnetic disks, 

flash memory drives, etc.) is generally known as Data Sanitization. A device that has been sanitized has no usable 

residual data and even advanced forensic tools should not ever be able to recover it, thus providing maximum level of 

security. 

Data Security Standards 

To irreversibly destroy all on-disk information there have been developed a number of disk sanitizing standards. They 

are distinguished by wiping patterns and number of passes: 

1. US DoD 5220.22-M. US Department of Defense recommends to overwrite all addressable locations with a 

character, its complement and then a random character. Finally, the target data area is to be verified; 

2. US Navy standards NAVSO P-5239-26. 

 NAVSO P-5239-26 for RLL encoded drives. At first to write the fixed value (0xffffffff) to the target data area, 

then the fixed value (0x27ffffff), and then random values. Finally, the target data area is to be verified; 

 NAVSO P-5239-26 for MFM encoded drives. At first to write the fixed value (0xffffffff) to the target data 

area, then the fixed value (0xbfffffff), and then random values. Finally, the target data area is to be verified; 

3. British HMG Infosec Standard No.5. At first to write a single character pattern, then its complement and then a 

random character. Finally, the target data area is to be verified; 

4. German VSItR Standard. Overwrite the deleted information 7 times, consistently filling it with the following 

patterns: 0x00, 0xFF, 0x00, 0xFF, 0x00, 0xFF, 0xAA. Finally, the target data area is to be verified; 

5. Australian ASCI 33. Overwrite with a character (C), then verify. Overwrite with –C (the first pass character’s 

inverse), then verify again. Overwrite everything with both C and –C once again but without verification. Fill 

everything with random characters; 

6. Russian GOST R 50739-95. Destroy information by a single pass with writing random characters into each sector 

byte; 

7. Peter Gutmann's algorithm. A whopping 35 passes, with 27 random-order passes using specific patterns 

combined with eight passes using random patterns; 

8. Bruce Schneier's algorithm. Two passes of specific patterns followed by five passes using a cryptographically 

secure pseudo-random sequence; 

9. Paragon's algorithm. 

 Overwrite each sector with a forcefully randomized 512-byte string, new for each sector, using CSPRNG 

(cryptographically secure pseudo-random number generator); 

 Overwrite each erased sector with its complement; 

 Overwrite each sector with a 512-byte string (CSPRNG), again forcefully randomized and different from the 

first pass, and new for each sector; 
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 Fill each erased sector with 0xAA value. Finally, the target data area is to be verified. 

 

Military and government standards always require 100 percent residual data verification. It 

is necessary to make sure that the operation has been properly accomplished. Besides 

corrupted sectors discovered during the operation are to be logged to keep the user 

informed, since these sectors may contain classified information. 

The list of supported military and government standards may vary for your product. 

Anyway you’ve always got the possibility to create a customized algorithm, defining up to 4 

wiping patterns, number of passes for each wiping pattern and for the group of patterns, 

thus providing the maximum possible security level. 

 

Dynamic Disks 

As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four 

primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to create 

logical drives within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows 

2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a maximum of four 

primary partitions, one of which can be an extended partition with logical drives. However, these operating systems also 

introduce a new disk configuration type - dynamic disk - which must be understood to effectively configure and manage 

hard disks. 

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only dynamic volumes. 

Regardless of what format you use for the file system, only Win2K computers can access dynamic volumes directly. 

However, computers that aren't running Win2K can access the dynamic volumes remotely when connected to the 

shared folders over the network. 

Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic and Dynamic 

disks on the same hard drive. 

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from free disk 

space that is linked together from multiple disks), striped (a volume the data of which is interleaved across two or more 

physical disks), mirrored (a fault-tolerant volume the data of which is duplicated on two physical disks, and RAID-5 

volumes (a fault-tolerant volume the data of which is striped across an array of three or more disks). 

With dynamic storage, you can perform disk and volume management without the need to restart Windows. 

Limitations: 

 Dynamic disks are not supported on portable computers. 

 Dynamic disks are not supported on Windows XP Home Edition-based computers. 

 You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows XP 

Professional, or Windows XP 64-Bit Edition-based computers. 

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more management 
flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimited number of volumes, but 
they cannot contain partitions or logical drives. Dynamic storage can be particularly beneficial for large-scale businesses 
when dealing with many physical hard disks involving complex setup. 
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GPT versus MBR 

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the 

old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC 

BIOS, it offers a number of crucial benefits: 

 Up to 128 primary partitions for the Windows implementation (only 4 in MBR); 

 The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR); 

 More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table; 

 A well defined and fully self-identifying partition format (data critical to the platform operation is located in 

partitions, but not in un-partitioned or hidden sectors as this is the case with MBR) 

uEFI Boot Challenges 

Introduced back in 2005 by Intel to lift restrictions of the old MBR (Master Boot Record) and PC BIOS (Basic 

Input/Output System), uEFI (Unified Extensible Firmware Interface) is now a recommended platform for new 64-bit 

Windows 8 computers. And the reason is easy to catch – besides other unique features impossible for the traditional 

tandem of BIOS+MBR, only a uEFI-based platform enables to accommodate Windows OS on a partition larger than 

2.2TB. 

Despite all uEFI advantages however, it has one quite naughty issue: A pretty standard operation with a bootable device 

for instance involving its connection to another SATA port results in unbootable Windows. You’ll get the same result if 

trying to boot from a cloned system hard disk or form a restored hard disk. All these problems originate from the way 

uEFI+GPT bundle is organized.  

Microsoft provides how-to guides to tackle this type of problems, but they demand a great deal of experience from the 

user, involving the use of the cmd, diskpart and bcdedit tools. 

Paragon has a better way! Introducing an elegant technology, realized at the user side as one simple option, you can 

define a system GPT volume you’re willing to boot from. 

Below is a list of wizards where the uEFI switch boot device option can be found: 

 Boot Corrector. 

 

 

The uEFI switch boot device option is only available through the 64-bit WinPE media at the 

moment. 

 

64-bit Support 

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user. 

However that is not the case when dealing with servers processing large amounts of data with complex calculations of 

very large numbers. That is where 64-bit architecture comes into play.  

It can boast improved scalability for business applications that enables to support more customer databases and more 

simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory 

allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor. 

With these resources, even a very large database can be cached in memory.  

Although many business applications run without problems on 32-bit systems, others have grown so complex that they 

use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources 
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are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the 

database. 

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-

level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged 

support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing. 

Scheduling  

The automation of operations is particularly effective when you have to repeat a sequence of actions on a regular basis. 

For example, developing a specific project on a day-to-day basis and having to make a backup every evening so as not to 

lose the valuable data, you will really appreciate, when this kind of routine operations will be carried out automatically 

without your participation. 

Another aspect of any automation process is that it allows an optimization of your computer’s work-load. This is 

especially important when operations require a considerable amount of computer resources – processor time, memory 

and more. A number of tasks, which can decrease the performance, can be run during the night or whenever the 

computer has the least work-load to perform. 

The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at a 

specified time without interrupting your current activity. 

Windows Components 

In the given section you can find all the information necessary to successfully work with the Windows version of the 

product. 

Interface Overview 

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being 

made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are 

accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program 

can be tackled by reading this very chapter. 

General Layout 

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and 

dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and 

functionality: 
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1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  

6. Disk Map  

7. Legend Bar 

8. Status Bar 

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them 

to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout. 

Main Menu 

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below: 

MENU ITEM FUNCTIONALITY 

Tools 

View Log Files View logs on the carried out operations 
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Send Log Files Compress and send the log to the Paragon Support Team 

Wiping Media Builder… Start up your computer for maintenance or recovery purposes 

Check Recovery Discs… Verify the wiping media for integrity and ability to boot from 

File Transfer Wizard… Transfer data from any media 

Settings... Edit the general settings of the program  

Exit Exit the program 

Changes 

Generate Script… Generate a script for the task 

Save to Scheduler… Schedule pending operations 

Undo `the last virtual 

operation` 

Cancel the last virtual operation on the List of Pending Operations 

Redo `the last virtual 

operation` 

Cancel the last undo virtual operation on the List of Pending Operations 

View Changes… Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info Refresh the current information about disks 

Wizards 

Wipe Hard Disk or 

Partition... 

Destroy all on-disk information or only remnants of deleted files/directories 

Hard Disk 

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

Wipe Hard Disk… Irreversibly destroy all on-disk information 

Edit/View Sectors… View/edit sectors of the selected hard disk 

Properties… Get in-depth information on the properties of selected hard disk 

Partition 

Create Partition… Create a partition 

Format Partition… Format a partition 

Delete Partition… Delete a partition 

Assign Drive Letter… Assign drive letter to the selected partition 
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Remove Drive Letter… Remove drive letter for the selected partition 

Wipe Partition… Irreversibly destroy all on-partition information 

Clear Free Space… Destroy any remnants of deleted files/directories left on disk 

Test Surface… Test surface of the selected partition/block of free space 

Check File System 

Integrity… 

Check the selected partition for possible file system errors 

Edit/View Sectors… View/edit sectors of the selected partition 

Properties… Get in-depth information on the properties of selected partition 

View 

Layouts Manage the Launcher layout with several predefined profiles 

Toolbar Manage the Tool Bar representation: show / hide standard and navigation 

buttons, text labels and large icons 

Status Bar Display the Status Bar 

Common Tasks Bar Display the Common Tasks Bar 

Disk Map Legend Display the Disk Map legend 

Disk Map Location Select whether the Disk Map will be located on the top of the main window or 

at the bottom 

Help 

Help Open the Help system (you can also do it by pressing F1) 

About Open the dialog with information about the program 

 

 

The Main Menu contents available at the moment may vary depending on the selected 

object. 

 

Tool Bar 

The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 

 

Irreversibly destroy all on-partition information 

 

Switch to Express launcher 
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Open the Help system 

Virtual Operations Bar 

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called 

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations 

immediately, but places them on the List of Pending Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 

 
Cancel the last virtual operation on the List of Pending Operations 

 
Cancel the last undo virtual operation on the List of Pending 

Operations 

 
Display the List of Pending Operations 

 
Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending Operations 

 

 

Virtual mode is an effective way of protection from any troubles, since no operations will 

be executed until clicking the Apply button for confirmation, thus giving a second chance to 

weigh all pros and cons of this or that particular operation. The program politely reminds 

the user that there are unsaved changes by showing the following window: 

 

 

Common Tasks Bar 

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's 

wizards. 

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it. 

Wiping Tools 

 
Starting the Wipe Wizard to help destroy all on-disk information or only remnants 

of deleted files/directories. 

 

Starting the Wiping Media Wizard to create a bootable media which can be used 

to get access to your hard disk for maintenance or recovery purposes. 

Help and Documentation 



25 

Copyright© 1994-2013 Paragon Software Group. All rights reserved. 

 
Launching the help system (you can also do it by pressing F1). 

 
Opening the page which contains information about the program. This page will 

be displayed in the Explorer Bar. 

 
Opening a brief review on the Data Sanitization issue. 

 
Opening a brief review on the Paragon Scripting Language. 

Disk Map 

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the 

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map 

Location). 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with 

rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the 

file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 

 Manufacturer, 

 Model. 

Small-sized bars display the following information about logical disks: 

 Serial number, 

 Drive letter, 

 Total size, 

 File system. 

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program 

offers to choose from several types of the disk layout scaling. It’s done especially to increase the program usability. For 

instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less 

than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the 

linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk 

layout is critical for you, the linear type is exactly what you need.  

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a partition is 

too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 



26 

Copyright© 1994-2013 Paragon Software Group. All rights reserved. 

 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will 
automatically display detailed information on it. 
 

 

The drag-and-drop functionality is not available when the logarithmic type of the disk 

layout is selected. 

 

Explorer Bar 

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays 

reference information including: 

 The help system 

 General information on the product including its name, version and a list of helpful links 

 Detailed information about disks selected on the Disk Map 

 List of scheduled operations 

 Disk Editor utility 

According to these categories the Explorer Bar has several tabs: 

 Disk View, which offers the user the following options: 

- Disk Editor to view/edit sectors of the selected partition/hard disk 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form 

 

 

You can switch between these components by clicking tabs on the left side of the Explorer 

Bar. 

 

 Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled operations and the 

program scripts. 

 Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the 

company's website to look through important technical notes or download the latest updates without having to close 

the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get additional information. 

To easily navigate through browsed pages, the program provides the following functionality: 

BUTTON FUNCTIONALITY 
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Return to the previously browsed page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the current page 

Legend Bar 

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with 

the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the 

Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32 

   - NTFS 

   - Linux Ext2/3/4 

   - Linux ReiserFS 

   - Apple HFS 

Status Bar 

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 

Settings Overview 

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, 

which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By 

selecting a section from the list, you can open a set of options. 

 

  

To get a detailed description to any setting, control, or field of the program just click the 

hint button and then the object you need. 

 



28 

Copyright© 1994-2013 Paragon Software Group. All rights reserved. 

General Options  

 

This section contains a set of general options that will be taken into account during any operation carried out with the 

program: 

 Partition Alignment mode. There are three options you can choose from: 

- Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder” 

or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When 

partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters, 

thus resulting in a double read-write operation. 

- Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing 

scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole 

disk drive. It is optimal for both, 512B and new 4K disk drivers. 

- Inheritance. Select the option to disable automatic alignment of partitions. 

 Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute, 

change cluster size, etc.) is potential with data loss. To minimize this risk, it’s recommended to check integrity of 

your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you 

several options to let you choose, which is best for you: 

- Always. Maximum protection, but minimal performance. The file system integrity will be checked each time 

it’s necessary to guarantee the maximum protection for the on-disk data. 

- Once. Standard protection with acceptable performance. The file system integrity will be checked for each 

volume only once just before accomplishing data-sensitive operations. 

- Never. No protection, but maximum performance. If you’re not 100% sure your disk is rock solid, please do 

not use this option. 

 Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been 

abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that 

correspond to the options below: 

- Do not protect. No protection, but maximum performance. If you’re not 100% sure you’re completely safe 

from a power outage, or an accidental reset of your computer, please do not use this option.  
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- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program 

enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your 

computer from our bootable wiping media, thus reviving the corrupted partition. 

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also 

disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a 

power outage. 

Wipe Options 

 

Here you can set a specific data erasure algorithm that will be used by default during wipe operations. 

 

 
The list of supported military and government standards may vary for your product. 

 

Wipe Report Options 

 

In this section you can specify contents and properties of generated wipe reports: 

 System information. Mark the option to include a computer name, BIOS version and the used operating system. 
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 Hardware Information. Mark the option to include information on the used processor, disk drivers, network and 

USB adapters, etc.  

 Bad blocks information. Mark the option to include information on the found bad blocks. 

 Supervisor Approval. Mark the option to add a signature field for an executive or supervisor responsible for 

data sanitization procedures in your company. 

 Font size… Select the most suitable font size from the list (12 pts by default). 

Partitioning Options 

 

This section contains a set of options that will be taken into account during partitioning operations: 

 Request confirmation before partition deletion. Mark the checkbox to activate an additional security 

mechanism. Thus when going to delete a partition you will be automatically requested to enter its label. 

 Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request 

confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion 

is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger 

hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get 

original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no 

way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition 

operation involving an extra upsizing. 

E-Mail Options 

 

This section contains a set of options that will be taken into account during the Send log files and Send e-mail 

notification operations: 
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 Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have access to 

a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the 

SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a 

traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. xxx.xxx.xxx.xx). 

 User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider or 

organization's e-mail administrator. 

 My outgoing server requires authentication. Activate the option to allow the program to make authentication 

on the server before sending messages. 

- User name. Enter the name that will be used to log in to the e-mail account. 

- Password. Enter the password that will be used to access the mail server. 

When you’re ready with the settings, click on the Send test e-mail button to check if everything is OK. 

 Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out operations.  

- Send mail in HTML format. Activate the option to create messages in the HTML format instead of plain text. 

- Send complete report after applying operations. Activate the option to create an in-depth report on the 

carried out operations and send it after performing the last operation. 

- Send graphical view of the disk sub-system before and after apply. Activate the option to allow the program 

to attach two pictures of the disk layout made before and after the operation is completed. 

 

 

By clicking the link at the bottom of the window you can jump to the Operation 

Dependency Options. 

 

Operation Dependency Options 

 

This section contains a set of options that will be taken into account when the Send e-mail notification on apply function 

is enabled. By marking/unmarking a checkbox opposite the required operation you can choose whether to receive an e-

mail notification on its completion or not. 
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You won't be notified if an operation requires the system restart. 

 

Virtual Mode Options 

 

In this section you may configure the virtual mode: 

 Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any 

troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all 

pros and cons of this or that particular operation. 

 

 
We strongly recommend you to enable this mode. 

 

 Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after 

accomplishing operations. 

Log Files Options 

 

In this section you can specify a storage life span for the stubact.log file: 

 Infinite not to empty the file ever; 

 Minimal to have the file emptied all the time; 

 Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the 

file will be emptied. 

 

 

We strongly recommend you not to choose the Minimal option, as in case of having 

problems with the program, our Support Team won’t be able to study operation logs, thus 

help you out. 
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Viewing Disk Properties  

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state 

of the computer’s hard disks. 

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-

sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information 

about the disk in a bright, graphical form. 

 

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a 

circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may 

see a table, which contains the following information: 

 Type of hard disk (basic or dynamic), 

 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All 

default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed 

description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard. 
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When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as 

well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in 

accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right 

will contain the following information: 

 Volume label (if available), 

 Type of the logical disk, 

 File system (represented by the color of the graph and the selected bar), 

 Total size, used space and free space (in GB or MB). 

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the 

disk settings. 

Partition Management 

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program. 

Basic Partitioning Operations 

Here you can learn how to accomplish basic partitioning operations (create, format, delete). 

Creating Partitions 

The program provides the ability to create a new partition within a block of un-partitioned space. 

Restrictions 

1. Do not use the Create Partition function in order to undelete the last deleted partition. 

2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free 

space on an existing partition to a new partition. 

3. The program cannot create new partitions on Dynamic Disks. 

Dialog Startup 

1. Select a block of free space on the Disk Map; 
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2. Select in the Main Menu: Partition > Create Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes 

button to confirm the operation. 

 

 Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type 

from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected 

block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free 

space, both Primary partitions or the Extended Partition can be created. 

 Partition Size. Define the size (in Mb) of the new partition. 

 Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free 

space. 

 Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition. 

 

  

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

 

 File system for new partition. From the pull-down list select a file system the newly created partition will be 

formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use). 
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 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

 Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 

 

 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Result 

After the operation is completed you receive a fully functional partition. 

Formatting Partitions  

Any partition should contain some file system to be used for keeping data. The process of installing a file system is 

commonly known as formatting. A huge variety of file systems have been developed these days. 

Supported File Systems 

The program provides the ability to format partitions of the following file systems: 

   - FAT12 & FAT16 

   - FAT32 

   - HFS+ 

   - NTFS 

   - Ext2 

   - Ext3 

   - Ext4 

   - Linux Swap v. 2 

Dialog Startup 

1. Select a partition on the Disk Map; 
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2. Select in the Main Menu: Partition > Format Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format 

button to confirm the operation. 

 

 File system. From the pull-down list select the desired file system type. In fact, the program displays only those 

file systems that can correctly be placed to the selected partition, taking its capacity into account. 

 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 

 

 Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 

 

  
Number of available options depends on the selected file system type. 

 

Result 

After the operation is completed you receive a fully functional partition formatted to the specified file system. 
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Deleting Partitions 

Dialog Startup 

In order to start the operation you should take the following steps: 

1. Select a partition on the Disk Map; 

2. Select in the Main Menu: Partition > Delete Partition. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Dialog Setup 

Initially the program suggests you just to remove references to the selected partition from the Partition Table.  

 

 Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume 

Label. The current volume label is displayed above. 

 Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog. 

To additionally destroy the on-partition data, click the More options button at the foot of the dialog page, so you will be 

able to define: 

 

 Select the byte mask…. The HEX value spinner control enables to set a two-figure hexadecimal character value 

("00" by default). The available range is from "00" to "FF". It is synchronized with the ASCII value. 

 Specify the number of wiping passes. You can choose a number of passes for the wiping pattern. 

 Verify wipe results. You can also choose whether to carry out residual data verification or not specifying the 

percentage of sectors to check. 
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Result 

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the 

modification of the disk layout. 

Hard Disk Management 

In this chapter you will find all the information necessary to carry hard disk operations supported by the program. 

Updating MBR 

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard 

bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a 

malfunction of boot management software. 

In order to update MBR of a hard disk you should take the following steps: 

1. Select a hard disk on the Disk Map. 

2. Select in the Main Menu: Hard Disk > Update MBR. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

3. The operation will be performed immediately after confirmation. 

Wipe Tasks 

In this chapter you will find all the information necessary to wipe a hard disk/partition of any file system or only destroy 

any remnants of deleted files/directories left on disk without affecting the used data, thus providing high level of 

security. 

The operation can be accomplished with the Wipe Wizard or corresponding dialogs. 

Wizard Startup 

 In the Main Menu: select Wizards > Wipe Hard Disk or Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 The hard disk/partition to wipe. Select a hard disk/partition the data of which you want to destroy. 
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 Wipe mode. This section enables to switch between two options: 

 

- Wipe out all data. Select the option to irreversibly destroy all on-disk data of the selected object. 

- Clear (wipe) free space. Select the option to destroy any remnants of deleted files/directories left on disk 

without affecting the used data. 

 

  

The Clear Free Space operation is available only for Logical and Primary partitions of known 

file systems. 

 

 Wipe method. Here you can select a specific data erasure algorithm or create a customized method by marking 

the appropriate option. 

 

- In case you preferred to use a specific algorithm, the next page of the wizard enables to get detailed 

information on the selected algorithm, choose whether to carry out residual data verification or not specifying 

the percentage of sectors to check and estimate the time required to accomplish the operation. 
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The list of supported military and government standards may vary for your product. 

 

- In case you preferred to create a customized algorithm, the next page of the wizard enables to define up to 4 

wiping patterns, number of passes for each wiping pattern and for the group of patterns. The Mask spinner 

control allows you to set a two-figure hexadecimal character value ("00" by default). The available range is from 

"00" to "FF". You can also choose whether to carry out residual data verification or not specifying the 

percentage of sectors to check. 

 

 Revise your changes. This page informs on all the actions to be made in the wizard in a bright, graphical form. 
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Wizard Result 

After the operation is completed you can see a well informative summary page, providing structurally divided in-depth 

information on all the actions made in the wizard. 

 

The program also enables to store the resulted report. To do that, just press the Save button and choose the exact 

location in the opened dialog. 

To make sure that all on-disk data is irreversibly destroyed call the Disk Viewer dialog by clicking the appropriate tab and 

see it for yourself. 

 

 

  
The Summary page will be available only when the Virtual operations are disabled. 
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Available operation scenarios: 

 Hard Disk Utilization 

Task Scheduling 

Automation of operations can really help you out when you’ve got to accomplish certain routine operations on a regular 

basis as it enables to execute them without your involvement while optimizing your computer’s work-load. 

Setting a Timetable 

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two categories for 

time settings (these correspond to appropriate items in the Schedule type menu): 

 Initiating the operation by an event: 

- One time only (i.e. the Once item) 

- When the system starts (i.e. the At System Startup item) 

- When the user logs on (i.e. the At Logon item). 

 Initiating the operation periodically (i.e. Daily, Weekly, Monthly). 

 

You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables to set a 

timetable. 

 

 

 

To run the task in the log-off mode, please specify administering login info by following the 

appropriate link in the left lower corner of the page. 
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The Shutdown System on Complete option enables to automatically switch off the 

computer on the successful accomplishment of the operation. 

 

Managing Tasks 

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab in the 

Explorer Bar: 

 

On every task you can get in-depth information, including: 

 The task name 

 The full path to the generated script of the task 

 Scheduled time of launch 

 Statistics on the last launch 

 Scheduled time of the next launch 

 Used account information 

 Comments to the task 

To easily manage tasks, the program enables to arrange them according to a certain characteristic just by clicking on the 

required property. 

 

 

This feature can be particularly beneficial when the Scheduled Tasks list contains too many 

items. 

 

You can also enable/disable, rename, delete, refresh or modify properties of the selected task. 

Task Editor  

With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the following 

steps: 

1. Select a task on the Scheduled Tasks list. 

2. Click the Properties button on the Scheduled Tasks list. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 
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3. In the opened dialog window you can see two tabs - General and Schedule. Click the General tab to modify: 

 Full path to the macro-command program-interpreter, which describes the scheduled task; 

 Command line for starting the interpreter (i.e. the task described in macro-language) 

 Comments referring to the task 

 The option of enabling/disabling the task. 

By clicking the Schedule tab you can modify the task timetable. 

In order to apply the changes, you need to click the Apply button at the foot of the dialog. 

Creating a Scheduled Task 

You can set a timetable for execution of any operation. For backup and copy operations the program offers handy 

wizards, while all the others can be scheduled with the Save to Scheduler dialog. 

To create a scheduled task you should take the following steps: 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to schedule; 

3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler…; 
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4. In the opened dialog enter the required task name and specify the task timetable; 

5. The operation will be performed immediately after confirmation. 

 

 
This command is unavailable if there are no operations on the List of Pending Operations. 

 

Scripting 

The program actions can also be represented in form of a script. The script describes the appropriate operation with 

macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included in the program installation 

package. This utility works in the unattended mode, which enables to automate operations. 

Startup 

You have no need to write a script since the program has a convenient interface for such a task. In order to generate a 

script on the base of the entered parameters of the required operation, you should take the following steps: 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to be scripted; 

3. Call the Generate Script dialog in the Main Menu: Tools > Generate Script…. 

Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Generate 

button to confirm the operation. 
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 Script file name and location. By default, the program offers to add the script to the Task List with a name 

containing its creation date and time. Unmark the Add to Task List checkbox to define an exact location and a 

filename for the script file. The default file extension that is reserved for scripting files is .psl, which however can 

be modified. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page, so you will be 

able to define: 

 

 Interaction with the user. Mark the option to pause the script interpreter during the execution to prompt the 

user’s confirmation or other input. Otherwise the program will not stop using default values for parameters if 

needed. 

 Commit after each operation. Mark the option to commit changes after each operation. 

 Check for errors after each operation. Mark the option to insert a special code in script, which checks the status 

of the last executed operation and stops the script processing if there are errors of any kind. 

 Discard all operations on close. Mark the option to empty the List of Pending Operations after generating the 

script. 

Result 

After the operation is completed you receive a new script file. It is placed into the specified destination, its features 

defined in the dialog. 

 

 

This command is unavailable if there are no operations on the List of Pending Operations. 

To learn more about scripts please consult the Paragon Scripting Language manual. 

 

Extra Functionality 

This chapter describes the supplementary functionality available in the program. 
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View Partition/Hard Disk Properties 

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general 

information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry, 

cluster size, exact partition location, etc. 

To get properties on a partition/hard disk, please do the following: 

1. Choose a partition/hard disk on the Disk Map. 

2. Select in the Main Menu: Partition/Hard Disk > Properties… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get 

information you need. 

File Transfer Wizard 

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to 

CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by 

a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon 

backups as regular folders to browse through their contents or copy required files. 

Startup 

 Select in the Main Menu: Tools > File Transfer Wizard. 
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There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the transfer operation: 

 Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the page. The 

program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it 

is possible to map a network drive. 

 

 Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by pressing the 

Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove 

button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane 

by pressing the appropriate buttons. 

 

 

 
Files/directories deleted from the Clipboard remain intact on source disks. 

 

 Destination to store the object(s). The File Transfer Wizard allows copying data to local or network drives, to 

physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will 

be stored. 
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 Revision of changes. The Transfer Summary page provides structurally divided information on all the actions 

made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the 

required hyperlink. 

 

Result  

After the operation is completed the required data will be placed into the specified destination. 

Available operation scenarios: 

 Copying of data from the corrupted system disk to another hard disk 

 Burning of data from the corrupted system disk to CD/DVD 

Mount Partition 

The program enables to assign or remove drive letters of existing formatted partitions. 

Assign Drive Letter 

In order to mount a partition you should take the following steps: 

1. Select a partition on the Disk Map.  

2. Select in the Main Menu: Partition > Assign Drive Letter… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this 

parameter. So you may just press the Yes button to confirm the operation. 
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However you can manually define the required letter by selecting it from the pull-down list of available drive 

letters.  

4. The operation will be performed immediately after confirmation. 

Remove Drive Letter 

In order to un-mount a partition you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Remove Drive Letter. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. The operation will be performed immediately after confirmation. 

 

 

Modifying drive letter of the system partition will result in inability to boot the operating 

system. 

After having processed partitions with installed software, some programs may not run 

properly. 

 

Test Surface 

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found 

any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss. 

In order to start the surface test you should take the following steps: 

1. Select a partition or a block of free space on the Disk Map. 

2. Select in the Main Menu: Partition > Test Surface… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

3. From the pull-down list choose the level of the surface check. 

 

4. The operation will be performed immediately after confirmation. 
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Check File System Integrity 

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before 

performing any operation on a partition. 

To start the system integrity check you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Select in the Main Menu: Partition > Check File System Integrity 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

3. The operation will be performed immediately after confirmation. 

Check Recovery Discs 

You’ve got the ability to check whether bootable media created with the program is 100 percent error-free and ready to 

use. The Check Recovery Disc Wizard will help you do that. 

Startup 

 In the Main Menu: select Tools > Check Recovery Discs… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

Setup 

The wizard offers the following steps to accomplish the operation: 

 CD/DVD drive. Select from the pull-down list of available CD/DVD devices the required drive to use during the 

operation. 

 

 Set whether to eject the disk after the operation is completed or not. 

Result 

After the operation is completed you can see results of the check. 
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Edit/View Sectors 

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks 

providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate 

through the system metadata, etc. 

In order to edit/view sectors of a hard disk/partition you should take the following steps: 

1. Select a hard disk/partition on the Disk Map. 

2. Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors. 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

 

 

 
Careless use of the Edit Sectors function may result in the irreversible data corruption. 
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Send Log Files 

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of 

having difficulties with handling the program, you, with the help of this very function, can address the company support 

engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in 

order to tackle the encountered problem. Information of that kind is stored in Log files. 

In order to send log files to the Paragon Support Team you should take the following steps: 

1. Call the Send Log Files dialog in the Main Menu: Tools > Send Log Files; 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. Provide a customer name and a product serial number; 

3. Give a detailed description on the encountered problem. 

 

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files 

and then send it to the Paragon Support Team. 

 

 

Log files do not contain any confidential information on the operating system settings or 

the user documents. 

The Send Log Files function is only available when outgoing mail server (SMTP) and the user 

e-mail address are properly set. To learn more about it please consult the Settings 

Overview chapter. 

 

View Logs 

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all 

the information is structurally divided, besides there is the possibility to see the disk layout before and after an 

operation, what is very convenient.  

In order to view logs on carried out operations select in the Main Menu: Tools > View Log Files 



55 

Copyright© 1994-2013 Paragon Software Group. All rights reserved. 

 

Typical Scenarios 

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can 

find here useful recommendations and descriptions of operations. 

Recovery Scenarios 

Correcting EFI parameters 

To specify a bootable device in the EFI boot entry, please do the following: 

1. Start up the computer from the WinPE recovery media. 

 

 

Please use Boot Media Builder to prepare the WinPE recovery environment, which you can 

get here: www.paragon-software.com/my-account/. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Select Boot Corrector from the start menu. 

3. Click Next on the Wizard's Welcome page. 

https://www.paragon-software.com/my-account/login.htm
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4. Select Correct EFI parameters to specify the required bootable device in the EFI boot entry. 

 

 

  

The option above will be available for the user, only if the operation is accomplished 

through the 64-bit WinPE media. 

 

5. The wizard will detect and list all available GPT partitions that accommodate 64-bit Windows OS. Choose the 

one you need to boot from, to let the wizard modify the EFI boot entry correspondingly.  

 

6. Confirm the operation. 

 

7. Click the Finish button to close Boot Corrector. 

8. Restart the computer. 

Correcting BCD (Boot Configuration Data) 

To automatically correct Windows BCD, please do the following: 
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1. Start up the computer from the WinPE recovery media. 

 

 

Please use Boot Media Builder to prepare the WinPE recovery environment, which you can 

get here: www.paragon-software.com/my-account/. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

 

2. Launch Boot Corrector. 

3. On the Wizard's Welcome page, click the Next button. 

4. Select Correct boot parameters… to let the wizard fix BCD in all found Windows installations. 

 

5. The wizard will ask you to confirm the operation. Apply the changes to complete. 

 

6. After completing the operation close the wizard, and then reboot the computer. 

Fixing Windows startup ability 

Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything 

seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up. 

To fix your Windows startup ability, please do the following: 

1. Start up the computer from our Linux/DOS wiping media. 

 

 

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a 

thumb drive. 

https://www.paragon-software.com/my-account/login.htm
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To automatically boot from the wiping media please make sure the on-board BIOS is set up 

to boot from CD/USB first. 

 

2. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well. 

3. On the Wizard's Welcome page, select the Search for Windows installations to correct option. 

 

4. On the next page choose the required Windows installation from the list of found installations (if several), then 

select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties 

button to get more info on the selected item. 

 

5. Examine the file – maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate 

buttons. 
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6. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to 

correct drive letters in the Windows System Registry. 

 

7. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not 

sure which installation you need, please use the Properties button to get more info on the selected item. 

 



60 

Copyright© 1994-2013 Paragon Software Group. All rights reserved. 

8. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System 

Registry. 

 

9. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button. 

10. Confirm the operation. 

 

11. After the operation is completed click the Report button to see a well informative summary page. The program 

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in 

the opened dialog. 

 

12. Click the Finish button to close Boot Corrector. 

13. Reboot the computer. 

Copying of data from the corrupted system disk to another hard disk 

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot, 

please do the following: 

1. Connect the second hard disk to the computer. 

2. Start up the computer from our Linux/DOS wiping media. 
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Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a 

thumb drive. 

To automatically boot from the wiping media please make sure the on-board BIOS is set up 

to boot from CD/USB first. 

 

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well. 

4. On the Wizard's Welcome page, click the Next button. 

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 

 

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

Click the Calc button to estimate the resulted data size. 

7. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive 

or a network share item. 
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8. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse 

button [...]. 

 

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

11. After the operation is completed, close the wizard by pressing the appropriate button. 

12. Turn off the computer. 

 

 
This operation can also be accomplished with our wiping media. 

 

Burning of data from the corrupted system disk to CD/DVD 

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the 

following: 

1. Start up the computer from our Linux/DOS wiping media. 

 

 

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a 

thumb drive. 

To automatically boot from the wiping media please make sure the on-board BIOS is set up 

to boot from CD/USB first. 

 

2. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well. 

3. On the Wizard's Welcome page, click the Next button. 

4. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 
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5. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

Click the Calc button to estimate the resulted data size. 

6. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item. 

 

7. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label 

by entering it in the appropriate field. 

 

8. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 
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9. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

10. After the operation is completed, close the wizard by pressing the appropriate button. 

11. Turn off the computer. 

 

 
This operation can also be accomplished with our wiping media. 

 

Hard Disk Utilization 

To irreversibly destroy all on-disk information without any possibility to recover and that way providing the maximum 

level of security, please do the following: 

1. In the Main Menu: select Wizards > Wipe Hard Disk or Partition… 

 

 

There are other ways to start up this function, please consult the Interface Overview 

chapter to know more on the subject. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Select a hard disk, the data of which you want to wipe out. 

 

4. On the Wipe Mode page, select the wipe out all the data to irreversible destroy all on-disk information. 

 

5. On the Wipe Method page select a specific data erasure algorithm or choose to create a customized one (in our 

case we prefer to use a certified military standard). 
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The list of supported military and government standards may vary for your product. 

 

6. The next page of the wizard enables to get detailed information on the selected algorithm, choose whether to 

carry out residual data verification or not specifying the percentage of sectors to check and estimate the time 

required to accomplish the operation. 

 

7. Review all parameters of the operation and modify them if necessary. 

 

8. Complete the wizard and then apply the pending changes. 

Extra Scenarios for WinPE 
 

 

Please use Boot Media Builder to prepare the WinPE environment, which you can get here: 

www.paragon-software.com/my-account/. 

 

https://www.paragon-software.com/my-account/login.htm
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Adding specific drivers 

Our WinPE based environment offers excellent hardware support. Anyway you’ve got the option to add drivers for 

specific hardware with a handy dialog. 

To add drivers for specific hardware, please do the following: 

1. Click Load Drivers. 

2. In the opened dialog browse for an .INF file of the required driver package located on a floppy disk, local disk, 

CD/DVD or a network share. Then click the Open button to initiate the operation 

 

 

 
To know how to map a network share, please consult the Configuring network scenario. 

 

3. You will be notified on the successful accomplishment of the operation. Click Yes to load another driver or No to 

close the dialog. 

 

 

 
Our WinPE environment is 32-based, thus you need to use 32-bit drivers for injection. 
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Configuring network 

If your local network has a DHCP server, a network connection will be automatically configured once our WinPE 

environment has been started up. Otherwise you will need to do it manually with a handy dialog by providing an IP 

address, a network mask, default gateway, etc. Besides with its help you can easily map network shares.   

To manually set up a network connection and map a network share, please do the following: 

1. Click Configure Network. 

2. In the opened dialog provide an IP address, a network mask, default gateway, etc. for your network device. 

 

3. Click the Network drivers tab to map a network share. 

 

4. Click Map Network Drive and provide all the necessary information to map a network share in the opened 

dialog:  
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 Click the standard browse button [...] to browse for the required network share or manually enter a path to 

it; 

 Define a letter from the pull-down list of available drive letters; 

 Click the Connect as user button at the foot of the dialog page to specify a user name and password to 

access the selected network share if necessary. 

By clicking Disconnect Drive… you can delete an existing network share if necessary. 

5. Click the Network identification tab to change a network name of your computer (generated automatically) and 

a workgroup name. 

 

6. By default, the wizard saves all network settings in the netconf.ini file located on the WinPE RAM drive, thus it 

will only be available until you restart the computer. However, you can just once configure your network device 

and then save this file to some other destination, for instance a local drive, and this way avoid constant re-

configuration, just by providing a path to it. So Click Save to file to save the netconfig.ini file to the required 

destination. 

Network troubleshooter 

Network Configurator includes a traceroute/ping utility that enables to get detailed information on particular routes and 

measure transit delays of packets across an Internet Protocol (IP) network. So with its help you can easily track down 

problematic nodes. 

1. If you need to ping some network host, please select Ping, then type in the required IP address or its name. Click 

Start when ready. 
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 Ping the specified host until stopped. Mark the option to ping the chosen host for indefinite time; 

 Resolve addresses to hostnames. Mark the option to display hostnames instead of IP addresses. 

 Number of echo requests to send. By default the utility sends 4 echo requests, which you can modify 

however. 

2. If you need to trace a route to some network host, please select Trace route, then type in the required IP 

address or its name. Click Start when ready. 

 

 Do not resolve addresses to hostnames. Mark the option to display IP addresses instead of hostnames. 

 Maximum number of hops to search for target. By default the utility goes through maximum 30 hops when 

searching for the target host, which you can modify however. 

 Wait timeout milliseconds for each reply. By default the utility waits 4 seconds for each echo reply 

message. If not received within the timeout, an asterisk (*) is displayed. 

Saving log files 

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of 

having difficulties with handling the program, you, with the help of this very function, can address the company support 

engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in 

order to tackle the encountered problem. Information of that kind is stored in log files. 

To prepare a log files package, please do the following: 

1. Click Log Saver. 

2. Provide an e-mail address used for registering the product, then give a detailed description on the encountered 

problem in the corresponding text fields. Please don’t worry - we respect your privacy, so none of your 

confidential data will be exposed. This utility only collects the program’s operation logs to help our Support 

Team find and tackle your problem. Click Next to continue. 
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Log files do not contain any confidential information on the operating system settings or 

the user documents. 

3. Browse for the required location of the log files package or manually provide a full path to it. Click Save to 

initiate the operation.  

 

 
This function is also available under Windows. 
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Troubleshooter 

Here you can find answers to the most frequently asked questions that might arise while using the program. 

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the computer. 

There are a number of operations that cannot be performed while your partition is in use (or locked in other 

words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-

up mode. 

2. I run an operation and restart the machine as required, but it just boots back into Windows without 

accomplishing the operation. 

Please run 'chkdsk /f' for the partition in question. 

3. I cannot create a new partition on the disk. 

There can be a number of reasons for that: 

 The program cannot create a new partition on a dynamic disk. 

 The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert 

a free space on an existing partition to a new partition. 

4. I cannot copy a partition. 

There can be a number of reasons for that: 

- The source or target disk you select is a dynamic disk; 

- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk. 

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed circle sign no 

matter which partition is selected. 

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free 

space on your hard disk, please delete or reduce an existing partition to accomplish the operation. 

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area on it. 

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the 

issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a 

standard code to your flash drive. 

7. When trying to back up my system the program asks to restart the computer. 

Most likely the Hot Processing mode is disabled. Please make it active in the program settings. 

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could 

not be started for processed volume". 

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot 

Processing mode instead. 

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the 

following error: Hard Disk management, Error Code 0x1100a. What is wrong here? 

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this 

service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My 

Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to 

start it automatically). 



72 

Copyright© 1994-2013 Paragon Software Group. All rights reserved. 

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error code 

0x1200e "Internal error during Hot Backup" 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error code 

0x12016 "VSS: can't read volume data” 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

12. When trying to back up to a network share, I get the following error: "i/o error" or "can't open/create file" 

Please check whether you’ve got a permission to write to the selected destination or not. 

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or 

"Archive does not fit" 

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa. 

14. I set up a timetable for a task, but it fails to execute. 

There can be a number of reasons for that: 

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call 

Notepad through scheduling); 

- You don’t have permission to write to the selected backup destination. 

Glossary  

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary 

partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.  

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap. 

The term backup originates from the time when the best way to protect valuable information was to store it in form of 

archives on external media. It’s become now a general notion to mean making duplications of data for protection 

purposes. 

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will 

be able to restore the data from these archives without having to run the program, but by simply booting from these 

CD/DVDs. 

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows 

organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the 

more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based 

on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of 

fragmentation on the volume. A cluster is also called an allocation unit. 

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is 

used if you want to create more than four volumes on a disk, since it may contain multiple logical drives. 

File System Metadata. The servicing structures of a file system, which contain information about allocating files and 

directories, security information etc, are named the file system metadata. It is invisible for users and regular 

applications because its accidental modification usually makes a partition unusable. 
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Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are 

divided into tracks (or heads), and tracks are divided into sectors. 

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk 

Geometry or C/H/S geometry. 

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an 

essential role in the DOS Partitioning scheme. 

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors 

are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can 

additionally emulate the C/H/S geometry. 

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an 

operating system does not mount a hidden partition, thus preventing access to its contents. 

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by 

XOR-ing the partition ID with a 0x10 hexadecimal value. 

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It 

contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a 

FAT file system. 

MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains important 

information about the disk layout: 

- The used partitioning scheme; 

- The starting records of the Partition Table; 

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses). 

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.  

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed 

to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot 

Manager are located in the 0th track. 

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect 

partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions. 

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space. 

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot 

sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK 

utility. 

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively 

large amount of text in multiple languages. 

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions 

located on a hard disk. 

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It 

was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible 

computers. 

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX 

mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating 

system. 
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Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new 

Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition, 

most hard disk utilities do not support it as well. 

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or 

recovery purposes. 

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file 

systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12 

and FAT16 file systems. 

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number 

represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is 

initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility. 

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows 

NT, 2000 and XP store its value in the database of assigned drive letters. 

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when 

the partition is formatted. It does not play an important role for most operating systems and software as well. 


